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Plugin overview

Function of the plugin

The HID SNP Genotyper Plugin is a software plugin that runs on the Torrent Server
and configured on the Torrent Browser. The plugin analyzes barcoded runs, then
finds the genotype at positions specified in the hotspot file. The plugin is based on the
Torrent Variant Caller, but unlike the Torrent Variant Caller, it analyzes only hotspot
locations, detects only SNPs, and does not detect indels.

The HID SNP Genotyper Plugin currently supports the Precision ID Ancestry Panel
and the Precision ID Identity Panel. The plugin produces an HID SNP Genotyper
Report that summarizes the data and analysis. The data can be exported for
additional analysis.

Plugin features

• Admixture prediction using Ancestry Informative Markers (AIMs) for seven
continental populations

• Y haplogroup identification
• Quality checks (QC) for each SNP
• Random Match Probabilities (RMP) calculation using the 1000 Genomes data set

Access Torrent Suite™ Software information

Visit thermofisher.com/torrent-suite-software-docs.html to access Torrent Suite™

Software Help and current Release Notes.

Torrent Suite™ Software is required for sequence analysis of libraries prepared with
Precision ID Library Kits. Once installed, the HID SNP Genotyper Plugin can be used
to call genotypes in the genomic regions covered by Precision ID panels.

1
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System requirements

Requirements to run the HID SNP Genotyper Plugin:
• Ion S5™ System—Torrent Suite™ Software 5.2.2
• Ion PGM™ System—Torrent Suite™ Software 5.2.2

Requirements to access the data generated from the HID SNP Genotyper Plugin:
• Google™ Chrome™

Note: The plugin performs optimally using the Google™ Chrome™ web browser.
This application is not recommended for use with other web browsers.

Chapter 1 Plugin overview
System requirements 1
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General procedures

■ Install the plugin . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

■ Download and install hotspots and targets files . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

■ Run the plugin . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

Install the plugin

1. To install the plugin, sign in to the Torrent Server via the Torrent Browser.

2. Select , then click Plugins.

3. Click Install or Upgrade Plugin.

4. In the Install or Upgrade Plugin dialog, click Select File, navigate to and select
the HID_SNP_Genotyper_v5_2_2 file, then click Upload and Install.

5. When the upload completes, refresh the web page to ensure that the upload was
successful.

6. In the HID_SNP_Genotyper row, select the checkbox to enable the plugin.
See Torrent Suite™ Software Help for further information.

Download and install hotspots and targets files

1. Go to www.ampliseq.com, then click Human Identification under Pre-designed
Panels.

2. Click on the Sign in to order button for the appropriate HID panel, then log in
with your Thermo Fisher Scientific account information.

3. Click on the Download panel files button, then Download Now.
Panel-specific target and hotspot BED files are downloaded:

• Precision ID Ancestry Panel
– PrecisionID_AncestryPanel_targets.bed
– PrecisionID_AncestryPanel_hotspots.bed

• Precision ID Identity Panel
– PrecisionID_IdentityPanel_targets.bed
– PrecisionID_IdentityPanel_hotspots.bed

When the download is complete, install the targets and hotspots *.bed files.

2

Download the BED
files
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Note: Do not install the *.json file; it is installed in a later setup stage.

1. Log in to the Torrent Server via the Torrent Browser.

2. Select , then click References.

3. In the left navigation pane, select Target Regions, then click Add Target Regions.

4. Click Select File, then navigate to and select the
PrecisionID_AncestryPanel_targets.bed file.

5. From the Reference dropdown list, select hg19 - Homo sapiens hg19.

6. (Optional) Enter a description and notes.

7. Click Upload Target Regions File.

8. Refresh the web page to ensure the upload was successful.

9. In the left navigation pane, select Hotspots, then click Add Hotspots.

10. Click Select File, then navigate to and select the
PrecisionID_AncestryPanel_hotspots.bed file.

11. From the Reference dropdown list, select hg19 - Homo sapiens hg19.

12. (Optional) Enter a description and notes.

13. Click Upload Hotspots File.

14. Refresh the web page to ensure the upload was successful.

15. Repeat steps 2−14 to install the PrecisionID_IdentityPanel_targets.bed and
PrecisionID_IdentityPanel_hotspots.bed files.

Run the plugin

Two types of runs are available for the HID SNP Genotyper Plugin:
• Planned Run (page 10)—Use this type of run when configuring the plugin

through the Planned Run Wizard.
• Reanalyze Run (page 15)—Use this type of run to reanalyze the data with
different parameters.

Install the
configuration files
in Torrent Suite™

Software

Chapter 2 General procedures
Run the plugin 2
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Use this procedure to configure the plugin during Planned Run creation so that the
plugin runs automatically after a sequencing run.

1. Log in to the Torrent Server via the Torrent Browser.

2. Select Plan4Templates.

3. In the navigation pane, click Human Identification, then click the appropriate
Applied Biosystems Precision ID Ancestry or Identity Panel template from the
Template Name list

4. In the Plan tab, enter and select the following options.

Note: Sample name information is transferred to the Converge™ Software with
the results.

Option Action

Run Plan Name (required) Enter a name for the run plan. Do not use spaces or
special characters.

Analysis Parameters Select Default (Recommended)

Reference Library Select hg19

Target Regions Select PrecisionID_AncestryPanel_targets.bed or
PrecisionID_IdentityPanel_targets.bed

Hotspot Regions Select PrecisionID_AncestryPanel_hotspots.bed or
PrecisionID_IdentityPanel_hotspots.bed

Use same reference &
BED filles for all barcodes

Leave the option selected.

Number of barcodes Select the appropriate number of barcodes.

Sample Tube Label Leave blank (recommended); information is auto-
populated during the Ion Chef™ template preparation
run.

Chip ID Leave blank Information is auto-populated after the
Ion Chef™ template preparation run).

Barcode Select the appropriate information from the drop-down
list.

Sample (required) Enter a name for each sample. Do not use spaces or
special characters.

Control Type Leave blank.

Create a Planned
Run

Chapter 2 General procedures
Run the plugin2
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Option Action

Sample ID • If not including a control—Sample ID is optional.

• If including a control—Enter a Sample ID using
this naming convention:
<Name of your choice>--<Control Type>-
<Control Name> , where

– Control Type is PC or NTC (positive or
negative control)

– The Control Name is provided in the control
profile file.

1

1 In this example, 9947A is the Control
Name.

Example positive control name: Sample1234--
PC-9947A
Example negative control name: Sample5678--
NTC-NegCtrl

Sample Description (Optional) If you have already created a case for this
sample in the Converge™ Software, enter the Case ID.

Reference Leave blank.

Bead Loading (%) Use default (30)

Key Signal (1-100) Use default (30)

Usable Sequence (%) Use default (30)

5. Click the Ion Reporter tab, confirm the following options, then click Next.
• Ion Reporter Account—None (default)
• Sample Grouping—Self

6. In the Application tab, confirm the following options, then click Next.
• Application—Human Identification (default)
• Target Technique—AmpliSeq DNA (default)

Chapter 2 General procedures
Run the plugin 2
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7. In the Kits tab, select the appropriate options according to the following table,
then click Next.

Option Action

Sample
Preparation Kit

Leave blank.

Library Kit Type • For manual library preparation, select Ion AmpliSeq 2.0
Library Kit.
IMPORTANT! For HID applications, Ion AmpliSeq 2.0
Library Kit is the appropriate selection for use with the
Precision ID Library Kit.

• For library preparation using the Ion Chef™ System, select
Ion AmpliSeq Kit for Chef DL8.

Note: The Ion AmpliSeq Kit for Chef DL8 option is only
available on Torrent Suite™ Software v5.0 and later.

Templating Size Select 200.

Template Kit Select the appropriate template kit. For example:

• Ion OneTouch™ 2 System:
Select OneTouch, then select Ion PGM Hi-Q OT2 Kit - 200
from the dropdown list.

• Ion Chef™ System:
Select IonChef, then select Ion Hi-Q Chef Kit from the
dropdown list.

Sequencing Kit Select the appropriate sequencing kit. For example:

• PGM: Select Ion PGM Hi-Q Sequencing Kit.

• S5: Select Ion S5 Sequencing Kit.

Flows Enter 500.

Control
Sequence

Leave blank.

Chip Type Select the appropriate chip type.

Barcode Set Select IonXpress or IonCode.

Note: The IonCode option is only available on Torrent Suite™

Software v5.0 and later.

Mark as PCR
Duplicates

Leave the option deselected.

Base Calibration
Mode

Select Default Calibration.

Enable
Realignment

Leave the option deselected.

8. In the Plugins tab, select then configure the HID SNP Genotyper Plugin:
a. Click Clear Selections, select HID_SNP_Genotyper, then click the blue
Configure link.

Chapter 2 General procedures
Run the plugin2
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b. In the Plugin Configuration dialog box, select the appropriate options
according to the following table.

Option
Action

Precision ID Ancestry Panel Precision ID Identity Panel

SNP Panels Select one or both of these SNP Panels:

• Admixture Prediction –  AISNPs

• Population Likelihoods –  AISNPs

Select one or both of these SNP Panels:

• 1000 Genomes –  IISNPs

• Y Haplogroup Prediction –  Y SNPs

Trim Reads Select Trim Reads Select Trim Reads

Minimum allele
frequency

Enter the appropriate values

Note: We recommend the default values.

Enter the appropriate values

Note: We recommend the default values.
Minimum coverage

Minimum coverage
on either strand

Maximum strand bias

c. Click Save Changes to close the dialog box, then click Next.

9. (Optional) In the Projects tab, assign a project, then click Next.

• Select an existing project from the list.
– or– 

• Click Add Project, then enter one or more project names.

10. In the Plan tab, select the appropriate options according to the following table,
then click Plan Run.

Option
Action

Precision ID Ancestry Panel Precision ID Identity Panel

Run Plan Name Enter a name for the Run Plan. Enter a name for the Run Plan.

Reference Library Select hg19(Homo sapiens hg19). Select hg19(Homo sapiens hg19).

Target Regions Select
PrecisionID_AncestryPanel_targets.bed.

Select
PrecisionID_IdentityPanel_targets.bed.

Hotspot Regions Select
PrecisionID_AncestryPanel_hotspots.bed.

Select
PrecisionID_IdentityPanel_hotspots.bed.

Use same reference
& BED files for all
barcodes

Select the option. Select the option.

Number of barcodes Enter the number of barcodes. Enter the number of barcodes.

Sample Tube Label (Optional) Enter the Sample Tube Label. (Optional) Enter the Sample Tube Label.

Enter a sample
name…

• Enter a unique name for each sample.
For replicates, use distinguishing characters (for example, <sample name>_R1).

• (Optional) Enter an ID and description for each sample.

Add a note (Optional) Add a note for your laboratory needs.

Chapter 2 General procedures
Run the plugin 2
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Option
Action

Precision ID Ancestry Panel Precision ID Identity Panel

Add LIMS Meta Data (Optional) Add LIMS Meta Data for tracking purposes.

Monitoring
Thresholds

Accept the default settings:

• Bead Loading (%): ≤30

• Key Signal (1– 100): ≤30

• Usable Sequence (%): ≤30

Accept the default settings:

• Bead Loading (%): ≤30

• Key Signal (1– 100): ≤30

• Usable Sequence (%): ≤30

When the run is complete, go to Chapter 3, “View and interpret results“.

Chapter 2 General procedures
Run the plugin2
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Use this type of run to reanalyze data, for example, if the experiment requires a
different BED file or parameters.

1. Log in to the Torrent Server via the Torrent Browser.

2. Select Data4Completed Runs & Results, then click a Report Name to view the
run summary.

3. In the run summary page, click Plugin Summary to scroll to the bottom of the
page, then click Select plugins to run.

4. In the dialog, select HID_SNP_Genotyper from the list.

5. In the HID SNP Genotyper Plugin dialog, select the appropriate options
according to the following table, then click Submit.

Option
Action

Precision ID Ancestry Panel Precision ID Identity Panel

SNP Panels Select one or both of these SNP Panels:

• Admixture Prediction –  AISNPs

• Population Likelihoods –  AISNPs

Select one or both of these SNP Panels:

• 1000 Genomes –  IISNPs

• Y Haplogroup Prediction –  Y SNPs

Targeted Regions Select
PrecisionID_AncestryPanel_targets.bed.

Select
PrecisionID_IdentityPanel_targets.bed.

Hotspot Regions Select
PrecisionID_AncestryPanel_hotspots.bed.

Select
PrecisionID_IdentityPanel_hotspots.bed.

Trim Reads Select Trim Reads. Select Trim Reads.

Minimum allele
frequency

Enter the appropriate values.

Note: We recommend the default values.

Enter the appropriate values.

Note: We recommend the default values.
Minimum coverage

Minimum coverage
on either strand

Maximum strand bias

When the run is complete, go to Chapter 3, “View and interpret results“.

Reanalyze

Chapter 2 General procedures
Run the plugin 2
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View and interpret results

■ About the HID SNP Genotyper Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

■ View results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

■ Summary pane . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

■ Sample Table pane . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20

■ Allele Coverage pane . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

■ Results pane – Ancestry Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

■ Results pane –  Identity Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28
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About the HID SNP Genotyper Report

The HID SNP Genotyper Report is the output of the HID SNP Genotyper Plugin and
contains the plugin results.

• To open the report, see “View results“ on page 18.
• To interpret the results, follow the procedures for each section of the report.

IMPORTANT! Unless otherwise noted, the HID SNP Genotyper Report features are
the same for both the Precision ID Ancestry Panel and the Precision ID Identity Panel.

1

2

3

4

Example HID SNP Genotyper Report (Ancestry Panel results)
1 Sample Table pane
2 Summary pane
3 Results pane
4 Allele Coverage pane

Chapter 3 View and interpret results
About the HID SNP Genotyper Report 3
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View results

1. Log in to the Torrent Server via the Torrent Browser.

2. Search for the HID SNP Genotyper Report:
a. Select Data4Completed Runs & Results.

b. Use the search features to find the results report of interest.

c. Click the appropriate blue report link in the Report Name column.

3. In the analysis report page, click Plugin Summary to scroll to the bottom of the
report page.

4. Review the status of the plugin analysis.

Status Definition

Completed Plugin analysis was successful.

Queued System is processing other actions; your sample has been
submitted.

Started Plugin analysis has started.

Error Plugin analysis cannot be completed successfully.

5. Open the HID SNP Genotyper Report:
a. Click See plugin results above to scroll to the top of the report page.

b. Click HID_SNP_Genotyper.html to open the HID SNP Genotyper Report.

Chapter 3 View and interpret results
View results3
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Summary pane

The Summary pane contains run information and links to download the items
described in the following table:

Click… To download…

Targets BED The targets BED file.

Hotspots BED The hotspots BED file.

Parameters A *.json file that contains the parameters settings.

Sample table
Download

A *.csv file that contains the sample table.

The sample table includes the sample name, barcode, and genotype for
each SNP for all samples.

CSV.ZIP A *.zip file that contains a separate *.csv file for each sample in the
run.

Each *.csv file contains the allele coverage data for the sample.

Single CSV file A single *.csv file that contains the allele coverage data for all samples
in the run.

PDF report
Download

A *.pdf file of the HID SNP Genotyper Report (see page 19 for a
description of the PDF report).

31 2

1 Run information
2 Download links
3 Hide/Show the Summary pane

The *.pdf report (Example *.pdf reports for the Ancestry and Identity Panels,
respectively on page 20) contains the following sections:

• Report summary—Provides a brief summary of the run, including the reference
name and the BED files that were used.

• Sample details—Provides information for each sample in the run, including the
sample name, sample barcode, and the analysis name. The section provides
additional information for each sample, depending on the analysis used,
including:

– Admixture Prediction
– Population Likelihoods
– 1000 Genomes
– Y Haplogroup Prediction

PDF report

Chapter 3 View and interpret results
Summary pane 3

HID SNP Genotyper Plugin User Guide 19



Example *.pdf reports for the Ancestry and Identity Panels, respectively

Sample Table pane

The Sample Table pane lists all samples in the run. Use the Sample Table features as
follows:

Click… To…

Show Genotypes List the genotypes across all hotspots for a given sample.

Information is from the input BED file. The genotype order
depends on the sequence of the hotspots in the BED file.

Hide Genotypes Hide the displayed genotypes.

Barcode ID Select the sample to view.

Information for the selected sample is displayed in the Sample
Table (Show Genotypes), Results, and Allele Coverage panes.

Chapter 3 View and interpret results
Sample Table pane3

20 HID SNP Genotyper Plugin User Guide



Click… To…

Sample Data Download Open the Variant Caller output for the selected sample.

(Click-drag) Bar
between the Sample
Table and Results
panes

Resize the Sample Table pane.

Allele Coverage pane

The Allele Coverage pane contains the following tabs:
• Table (page 21)—Provides allele coverage details.
• Charts (page 23)—Displays the read coverage across hotspots.

The Table tab provides the allele coverage details for the selected sample.

1. In the Sample Table pane, click the Barcode ID for the sample of interest.

2. In the Allele Coverage pane, select the Table tab.

1

3

2

1 Click the Barcode ID for the sample of interest
2 Click-drag to resize the Allele Coverage pane
3 Select the Table tab

3. (Optional) Filter the data to display.

Review the Table
tab

Chapter 3 View and interpret results
Allele Coverage pane 3
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4. Review the Table tab using the following features:

Click… To…

Download coverage data Download the allele coverage table as a *.csv file.

Export Selected
(must first select the header row checkbox)

Export the selected results.

Compare Compare data from selected SNPs across all samples in the run.

Column header Sort the column by ascending/descending order.

Position column link Go to the IGV browser.

HotSpot ID column link Go to the NCBI web page for SNPs.

Table 1   Data displayed in the Allele Coverage Table tab

Column Description

Chrom Chromosome. The chromosome location of the SNP.

Position The position of the SNP on the chromosome.

HotSpot ID The reference SNP ID number.

QC Quality checks. See page 22 and page 35.

Cov Coverage. The number of aligned reads that cover this hotspot.

A Reads The number of aligned reads that have allele A at this hotspot.

C Reads The number of aligned reads that have allele C at this hotspot.

G Reads The number of aligned reads that have allele G at this hotspot.

T Reads The number of aligned reads that have allele T at this hotspot.

Pos Cov Positive Coverage. (+) strand coverage.

Neg Cov Negative Coverage. (– ) strand coverage.

Pos Cov % Positive Coverage percentage. The positive coverage divided by the total coverage. This is a
measure of strand bias.

Genotype Genotype calls at hotspot region.

GQ Genotype Quality. The Phred-scaled marginal probability of a called genotype.
The maximum value is 99. Lower values may be caused by strand bias, low signal
strength, or allelic imbalance.

Maj. Allele Freq (%) Major Allele Frequency percentage. The number of reads for the most frequently
appearing allele divided by the total number of reads for all alleles.
This value should be about 50% (heterozygote) or 100% (homozygote).

Quality checks (QC)

The Table tab displays the quality checks. If any of the QC metrics fail:
• The QC column cell displays as red.
• The individual metrics that failed display as red text.

For further information, see “Quality checks (QC)“ on page 35.

Chapter 3 View and interpret results
Allele Coverage pane3
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The Charts tab displays the read coverage across hotspots for the selected sample.

1. In the Sample Table pane, click the Barcode ID for the sample of interest.

2. In the Allele Coverage pane, select the Charts tab.

3. Review the Charts tab using the following features:

Click… To…

Show normalized allele
coverage

Display normalized allele coverages at each SNP with
regards to its total coverage.

Sort by coverage Sort the entire panel by increasing coverage.

Note: Default sorting is based on the sequence of
hotspots in the BED file.

Compare Compare data from selected SNPs across all samples
in the run. See step step 4 for detailed instructions.

(Hover over) SNP details View the details for the SNP.

Export icon Save the Coverage Plot in various formats.

3

1 2

4

6

5

1 Click the Barcode ID for the sample of interest
2 Click-drag to resize the Allele Coverage pane
3 Select the Charts tab
4 Select options for chart display
5 Click icon to export files
6 Hover over data points to display SNP details

4. Compare data from selected SNPs across all samples in the run:
a. Click-drag on the bottom of the chart to select a region.

The region highlights in green.

Review the Charts
tab

Chapter 3 View and interpret results
Allele Coverage pane 3
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b. Click-drag around specific SNPs in the highlighted region.

c. Click Compare to show the comparison results for two selected SNPs.

Results pane – Ancestry Panel

The Results pane for the Ancestry Panel contains the following tabs:
• Population Stats (page 25 and page 27)—Displays the population statistics for

the selected sample. The population statistics vary and depend on the analysis
used by the HID SNP Genotyper Plugin: Admixture Prediction or Population
Likelihoods (see “Available analyses“).

• Profile Comparison (page 28)—Displays a pair-wise profile comparison for all
samples in the run.

For the Ancestry Panel, configure the plugin to use one or both of the following
analyses:

• Admixture Prediction—Use the Admixture Prediction analysis to find the most
likely combination of specific root populations that best explains the genotypes
observed in the sample of interest. This analysis provides an estimate of the
overall ancestral composition of the sample.
For example, use the Admixture Prediction analysis to determine if a sample is
predominantly of African origin or admixed between more than one population.

• Population Likelihood—Use the Population Likelihood analysis to calculate the
likelihood of the sample genotypes for a particular population based on its
allele/genotype frequencies. This analysis helps further resolve the results
obtained from the Ancestry Prediction analysis.
For example, for an African sample, use the Population Likelihood analysis to
find the sub-population (such as Ibo, Yoruba, Hausa) to which a sample is most
likely to belong.

Note: This level of resolution can be beyond the design of the SNPs in the panel.

Available analyses

Chapter 3 View and interpret results
Results pane – Ancestry Panel3
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For the Admixture Prediction analysis, use the Population Stats tab features:

1. In the Sample Table pane, click the Barcode ID for the sample of interest.

2. In the Results pane, click Admixture Prediction to display the following subtabs:

• Map—see page 25
• Results—see page 25
• Genotypes—see page 26

Review the Admixture Prediction ► Map subtab

The Map subtab displays a heat map overlaid on a world map. It provides a quick
way to view the most likely geographical origin of the selected sample.

The darkness of the color indicates the proportion of the corresponding population in
the sample. That is, the darker the color, the greater the proportion of the
corresponding population in the sample.

1. Select the Map subtab.

Note: If the Torrent Server cannot connect to the internet, the displayed heat
map is a static version.

2. Scroll to view the region of interest, if needed.

3. Hover over the region to display the proportion value of the corresponding
population in the sample.

Review the Admixture Prediction ► Results subtab

The Results subtab displays the proportions for all populations.

Note: Populations with a proportion of 0% are not visible in the plot.

1. Select the Results subtab.

2. Review the table at left, which lists the most likely geographical origin of the
selected sample.

3. Review the plot at right, which shows the distribution of log-likelihood values
and a level of confidence for the calculated results.
The confidence value answers the question: Given a random population that has the
same ancestral makeup as that of the test sample, what is the chance of observing the test
sample?

View the
Population Stats
► Admixture
Prediction

Chapter 3 View and interpret results
Results pane – Ancestry Panel 3
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To calculate the confidence value, the plugin will:

1. Simulate 10,000 random samples that have the same predicted admixture
proportions as the test sample.

2. Calculate the likelihood value for each simulated sample and the test
sample.

3. Generate a distribution of log-likelihood values from the simulated samples,
then compare the log-likelihood of the test sample to the distribution.

• The green region represents the 95% confidence interval. The 95%
confidence interval means that the tested sample is similar to a sample
obtained from 10,000 randomly generated samples.

• The black line indicates the log-likelihood of the tested sample. If the log-
likelihood (black line) falls inside the green region, confidence is high. If the
log-likelihood falls outside the green region, confidence is low.

Example Description

Confidence is high.

For degraded
samples, the
confidence value
decreases with the
level of degradation.

In this example, the
sample is so
degraded that there
are valid genotypes
for only 50% of the
loci. As expected, the
confidence is low.

Review the Admixture Prediction ► Genotypes subtab

The Genotypes subtab lists the genotypes of the SNPs that were used for analysis.

1. Select the Genotypes subtab.

2. Scroll to view the entire table, if needed.

Chapter 3 View and interpret results
Results pane – Ancestry Panel3
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For the Population Likelihoods analysis, use the Population Stats tab features:

1. In the Sample Table pane, click the Barcode ID for the sample of interest.

2. In the Results pane, click Population Likelihoods to display the following
subtabs:

• Map—see page 27
• Results—see page 27
• Genotypes—see page 28

Review the Population Likelihoods ► Map subtab

The Map subtab displays a heat map overlaid on a world map. It provides a quick
way to view the most likely geographical origin of the selected sample.

The intensity of the color indicates the proportion of the corresponding population in
the sample. That is, the darker the color, the greater the proportion of the
corresponding population in the sample.

1. Select the Map subtab.

Note: If the Torrent Server cannot connect to the internet, the displayed heat
map is a static version.

2. Scroll to zoom in and click-drag to pan around the map, if needed.

3. Click Show/hide populations, then hover over the pins to view the names of
each population.

Note: Location information for the following populations is not available, so the
map does not display these populations: Europeans-HapMap, Han-HapMap,
Yoruba-HapMap, Japanese-HapMap, Sephardic Jews, Ashkenazi Jews. However,
you can view likelihood values for these populations in the Results subtab (on
page 27).

Review the Population Likelihoods ► Results subtab

The Results subtab displays the likelihood values for the sample; that is, how likely it
is that the sample comes from each population used in this analysis.

1. Select the Results subtab.

2. Review the table, which lists all populations in the analysis, their geographical
regions, and the likelihood values.

View the
Populations Stats
► Population
Likelihoods

Chapter 3 View and interpret results
Results pane – Ancestry Panel 3
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Review the Population Likelihoods ► Genotypes subtab

The Genotypes subtab lists the genotypes of the SNPs that were used for analysis.

1. Select the Genotypes subtab.

2. Scroll to view the entire table, if needed.

The Profile Comparison tab displays a pair-wise profile comparison for all samples in
the run. It shows the percentage of alleles that are common between any two samples
in the current run. SNPs that have missing calls or No Calls (N) in both the samples
are ignored in the calculation.

1. In the Results pane, select the Profile Comparison tab, then review the results.
• Red cells indicate an allele match >75%.
• Yellow cells indicate an allele match ≤75%.

2. Click a cell to display:
• SNPs that are discordant between the two samples.
• SNPs that were ignored in the calculation.

Results pane –  Identity Panel

The Results pane for the Identity Panel contains the following tabs:
• Population Stats (page 29 and page 31)—Displays the population statistics for

the selected sample. The population statistics vary and depend on the analysis
used by the HID SNP Genotyper Plugin: Y Haplogroup Prediction or 1000
Genomes (see “Available analyses“ on page 28).

• Profile Comparison (page 28)—Displays a pair-wise profile comparison for all
samples in the run.

For the Identity Panel, configure the plugin to use one or both of the following
analyses:

• Y Haplogroup Prediction—Use this analysis to predict the Y lineage of the
sample.

• 1000 Genomes—Use this analysis to find the Random Match Probability (RMP)
for each of the five global populations from the 1000 Genomes data set.

Select analyses

Select the analyses before running the plugin (see “Create a Planned Run“ on
page 10).

Review the Profile
Comparison tab

Available analyses

Chapter 3 View and interpret results
Results pane –  Identity Panel3
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For the Y Haplogroup Prediction analysis, use the Population Stats tab features as
follows:

1. In the Sample Table pane, click the Barcode ID for the sample of interest.

2. In the Results pane, click Y Haplogroup Prediction to display the following
subtabs:

• Results—see page 29
• Genotypes—see page 31

Review the Y Haplogroup Prediction ► Results subtab

The Results subtab displays information about the identified haplogroup of a sample.

1. Select the Results subtab.

2. Scroll or expand to view the entire pane, if needed.
The Results subtab displays the following information:

Item Description

Haplogroup The identified haplogroup.

Profile The genotypes of the SNPs, provided in the Family Tree DNA
(FTDNA) format. Only loci that are in the derived state are
represented.
Use the profile information to search against third-party tools,
such as http://ytree.morleydna.com.

Incompatible loci Loci that are present in the derived state but are not
compatible with the identified lineage.

Y Tree The Y tree with clades that have been typed for this lineage.
Loci that define each clade are color-coded:

• Red—loci in the ancestral state (Ancestral SNP)

• Green—loci in the derived state (Mutant SNP)

• Grey—loci that do not have a valid genotype (No data)

Description A short description of the haplogroup, including details about
its origin and geographical distribution.

View the
Population Stats
► Y Haplogroup
Prediction

Chapter 3 View and interpret results
Results pane –  Identity Panel 3
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Simulated profile example 1

This example shows results from a simulated profile that can be assigned to both
haplogroups J and O.

The sample has both S35 (defines haplogroup J) and P186 (defines haplogroup O) in
the derived state. When considering the branch (lineage) leading up to clade J, locus
P186 is absent and is therefore incompatible.

Similarly, when considering the branch (lineage) leading up to O, both S35 and M429
are absent. In the O branch, loci M9 and M526 are in the ancestral state and there is no
data present for P193. These results indicate a genotyping issue and require a more
detailed review of the data.

Chapter 3 View and interpret results
Results pane –  Identity Panel3
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Simulated profile example 2

This example shows results from a simulated profile where no haplogroups were
found. These results indicate a female sample.

Review the Y Haplogroup Prediction ► Genotypes subtab

The Genotypes subtab lists the genotypes of the SNPs that were used for analysis.

1. Select the Genotypes subtab.

2. Scroll to view the entire table, if needed.

For the 1000 Genomes analysis, use the Population Stats tab features:

1. In the Sample Table pane, click the Barcode ID for the sample of interest.

2. In the Results pane, click 1000 Genomes to display the following subtabs:

• Results—see page 31
• Genotypes—see page 32

Review the 1000 Genomes ► Results subtab

The Results subtab displays the Random Match Probabilities (RMP) results.

1. Select the Results subtab.

2. Review the table, which lists all populations in the analysis, their geographical
regions, the RMP values, and the overall RMP range (minimum to maximum).

View the
Population Stats
► 1000 Genomes

Chapter 3 View and interpret results
Results pane –  Identity Panel 3
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Review the 1000 Genomes ► Genotypes subtab

The Genotypes subtab lists the genotypes of the SNPs that were used for analysis.

1. Select the Genotypes subtab.

2. Scroll to view the entire table, if needed.

The Profile Comparison tab displays a pair-wise profile comparison for all samples in
the run. It shows the percentage of alleles that are common between any two samples
in the current run. SNPs that have missing calls or No Calls (N) in both the samples
are ignored in the calculation.

1. In the Results pane, select the Profile Comparison tab, then review the results.
• Red cells indicate an allele match >75%.
• Yellow cells indicate an allele match ≤75%.

2. Click a cell to display:
• SNPs that are discordant between the two samples.
• SNPs that were ignored in the calculation.

Review the Profile
Comparison tab

Chapter 3 View and interpret results
Results pane –  Identity Panel3
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Calculations

■ Admixture Prediction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

■ Population Likelihoods . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34

■ 1000 Genomes (Random Match Probability) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34

■ Y Haplogroup Prediction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

■ Quality checks (QC) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

Admixture Prediction

The Admixture Prediction method finds the ancestral composition of a sample. From
a set of "root" populations, this method finds the most likely combination of these
populations that best explains the genotypes observed in the sample of interest.

As an analogy: If there are three known colors — red, green, and blue — and an
unknown color, the algorithm tries to find the best way to mix red, green, and blue to
obtain the same color as that of the unknown.

To determine how reliable the results are, the HID SNP Genoytper Plugin provides a
level of confidence for the calculated results. The confidence value answers the
question: Given a random population that has the same ancestral makeup as that of the test
sample, what is the chance of observing the test sample?

In general, confidence values are lower for degraded samples and for samples that
cannot be satisfactorily expressed as an admixture of the root populations.

Currently, the HID SNP Genotyper Plugin considers seven root populations:
• Africa
• America
• Southwest Europe (Middle East)
• Europe
• Oceania
• East Asia
• South Asia

151 Ancestry Informative Markers (AIMs) are used to calculate the admixture
proportions of these populations based on their genotype frequencies. The 151 SNPs
are a subset of Kidd’s 55 AIMs (Kidd et al. 2014) and Seldin’s 128 AIMs (Kosey et al.,
2009).

Download the list of loci and genotype frequency data from
https://s3-us-west-1.amazonaws.com/hid-ngs-public/ai151_regions.zip.

A

Data set
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Note: The AIM SNPs described above are a combined subset of Kidd and Seldin
SNPs when compared with previous versions of the HID SNP Genotyper Plugin (v4.3
and earlier). The results obtained from the 151 SNPs are more robust and reliable.

Population Likelihoods

The Population Likelihoods method calculates the ancestral population likelihood as
the product of genotype frequencies for each locus:

where,
• Lp is the likelihood of ancestral population P
• fp (g, i) is the frequency of genotype g at locus i
• N is the number of loci

The HID SNP Genotyper Plugin calculates the likelihood for 65 populations based on
the genotype frequencies of 151 SNPs.

Download the complete list of populations and frequency data from
https://s3-us-west-1.amazonaws.com/hid-ngs-public/ai151.zip. These data are also
available from the ALlele FREquency Database at http://alfred.med.yale.edu.

1000 Genomes (Random Match Probability)

The HID SNP Genotyper Plugin calculates the Random Match Probability (RMP) as
the product of genotype frequencies for each locus.

The HID SNP Genotyper Plugin calculates the RMP for the following five
populations:

• Africa
• Europe
• America
• East Asia
• South Asia

The calculation is based on:
• 85 unlinked identity SNPs of the 90 SNPs in the panel.
• The genotype frequencies obtained from the 1000 Genomes data set.

Download the genotype frequency data from
https://s3-us-west-1.amazonaws.com/hid-ngs-public/ii85_1000g.zip.

Data set

Data set

Appendix A Calculations
Population LikelihoodsA
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Y Haplogroup Prediction

The HID SNP Genotyper Plugin identifies Y haplogroups based on the
2014 ISOGG Y Tree at http://isogg.org/tree/index14.html. In addition, the HID SNP
Genotyper Plugin provides a short description of the identified haplogroup below the
Y Tree (see “View the Population Stats ► Y Haplogroup Prediction“ on page 29).

The prediction algorithm finds the longest branch (lineage) in the tree, then reports all
possible lineages. The plugin flags loci that can be incompatible (not in the derived
state) with a particular lineage and loci that have no genotypes.

To successfully identify a haplogroup, at least 30% of the Y SNPs should have a valid
genotype.

The HID SNP Genotyper Plugin identifies haplogroups based on the 34 Y SNPs in the
Precision ID Identity Panel.

Quality checks (QC)

In the Allele Coverage pane, the plugin applies locus-level quality checks to flag
possible bad data. The following table lists the checks that the plugin performs and
the conditions that raise an exception.

Quality check Condition that raises exception

Coverage Total coverage at locus is less than twice the standard deviation compared to the mean.
The genotyper calculates the mean and standard deviation independently for autosomal
and Y SNPs. This indicates drop-out.

Percent positive coverage The ratio of coverage from (+) strand to (– ) strand is <30% or >70%. This indicates strand
imbalance. 50% is perfect strand balance.

Major allele frequency The ratio of coverage of major allele to total coverage is:

• <95% for homozygotes

• <35% or >65% for heterozygotes

This indicates allele imbalance.

Genotype The genotype is not valid. Occasionally, a No Call (NN) may be observed even if all of the
above metrics are good. This is because the variant caller performs sophisticated data
analysis and looks at many other metrics. The exact reason for failure can be seen in the
VCF file.

Similarly, a genotype can be valid even if one or more of the above metrics fail. A flag
does not necessarily mean an incorrect result; the flag only indicates an unexpected
deviation from the norm and requires a more detailed review of the data.

The genotyper calculates the mean and standard deviation independently for
autosomal and Y SNPs. If the mean coverage for Y SNPs is <20, it is considered a
female sample. The genotyper does not perform quality checks for the Y SNPs, and
the QC column displays as gray. Because Y SNPs have no coverage for females, they
are not flagged.

Data set

QC for female
samples
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This appendix describes the results of the developmental experiments performed
using the Precision ID Identity Panel and the Precision ID Ancestry Panel for use with
forensic samples on the Ion PGM™ System.

About Ion AmpliSeq™ technology

Ion AmpliSeq™ technology enables complex PCR multiplexing while minimizing
primer-dimer formation. Both the Precision ID Identity Panel and the Precision ID
Ancestry Panel contain primers for PCR amplification using Ion AmpliSeq™

technology, and use a recommended sample input of 1 ng of genomic DNA. We chose
conditions that produce optimum PCR product yield and that meet reproducible
performance standards.

B
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Precision ID panel design

The Precision ID Identity Panel is made up of 124 markers; 90 autosomal markers and
34 upper Y-clade markers. The autosomal SNPs are from Ken Kidd’s 45- unlinked set
(Pakstis, et al. 2010) and from the SNPforID set (Kosey et al., 2009). The average size
for autosomal markers is 132 bp. The average size for upper Y-clade markers is 141 bp
(Karafet et al. 2008). Amplicon size distributions are shown in Figure 1. The
chromosomal location of the SNPs in the panel is shown in Figure 2.

Figure 1   Amplicon size distributions of SNP subsets in the Precision ID Identity Panel.

Precision ID
Identity Panel
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Figure 2   Chromosomal location of identity SNPs in the Precision ID Identity Panel.
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The Precision ID Ancestry Panel is made up of 165 autosomal markers; 55 from Ken
Kidd’s AIM set (Kidd et al. 2014) and 123 Seldin markers (Nassir et al. 2009). The
average size of the Ken Kidd markers is 130 bp. The average size of the Seldin
markers is 122 bp. Amplicon size distributions are shown in Figure 3. The
chromosomal location of the SNPs in the Precision ID Ancestry Panel is shown in
Figure 4.

Figure 3   Amplicon size distributions of SNP subsets in the Precision ID Ancestry Panel.

Figure 4   Chromosomal location of identity SNPs in the Precision ID Ancestry Panel.

Precision ID
Ancestry Panel
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Reference DNA samples

Thirty identity DNA samples and corresponding TaqMan® genotype data for 46 Ken
Kidd SNPs were provided by Dr. Ken Kidd (Pakstis et al. 2010). These samples were
used in the development of the Precision ID Identity Panel.

The input genomic DNA per PCR reaction ranged from 180 pg to 1 ng. The resulting
30 library samples were quantified by qPCR using the Ion Library TaqMan®

Quantitation Kit. Library samples were diluted and pooled before template
preparation and sequenced on a single Ion 318™ Chip v2.

A total of 24 ancestral DNA samples and corresponding TaqMan® genotype data for
55 Ken Kidd SNPs were provided by Dr. Ken Kidd (Yale University). These samples
were used in the development of the Precision ID Ancestry Panel.

The input genomic DNA per PCR reaction was 1 ng. Using the same workflow as in
testing of the identity samples, the resulting ancestral library samples were quantified
by qPCR, diluted, pooled, and sequenced on a single Ion 318™ Chip v2.

Performance metrics and panel evaluation

For the development of the Precision ID panels, a metric system was developed to
assess marker selections and panel robustness.

The metrics used in evaluating marker selections and overall panel performance are:
• Amplicon Strand Balance (Figures 5 and 6 on page 41)
• Amplicon Heterozygosity Balance (Figure 7 on page 41 and Figure 8 on page 42)
• Amplicon Coverage (Figures 9 and 10 on page 42)

These metrics were evaluated using data sets generated from the 30 samples provided
by Ken Kidd.

Amplicon Strand Balance is defined as the ratio of the minimum coverage strand
counts to the maximum coverage strand counts. The average Amplicon Strand
Balance should be 50±20% and have a strand ratio of >0.45 (see Figure 11 on page 43).
Target average Amplicon Heterozygosity Balance is 50±15%. The average Amplicon
Coverage across all markers should be within 2 standard deviations from the mean
(see Figure 12 on page 43).

Sequence coverage for both forward and reverse strands was checked. To minimize
heterozygosity bias, any amplicon where sequencing of one strand was favored over
the other strand was removed from the panel. Minimizing heterozygosity bias is
essential for ensuring equal representation of alleles, and eliminating false allele calls.

Precision ID
Identity Panel

Precision ID
Ancestry Panel
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Variability in Amplicon Coverage across the panel was minimized by removing
markers with lower sequencing performance as compared to other markers.

S
tra

nd
 ra

tio

Figure 5   Amplicon Strand Balance for the autosomal SNPs in the Precision ID Identity Panel across all markers.
Target average Amplicon Strand Balance is 50±20%. 95% of all markers were between 50–90%.
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Figure 6   Amplicon Strand Balance for the Precision ID Ancestry Panel across all markers. Target average Amplicon
Strand Balance is 50±20%. All markers were between 60–90%.
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Figure 7   Average Amplicon Heterozygosity balance of autosomal SNPs in the Precision ID Identity Panel across all
markers. Target average heterozygosity is 50±15%. The average heterozygosity across all markers was 35–45%.

Appendix B Experiments and results
Performance metrics and panel evaluation B

HID SNP Genotyper Plugin User Guide 41



H
et

er
oz

yg
os

ity
 F

re
qu

en
cy

Figure 8   Average Amplicon Heterozygosity balance for the Precision ID Ancestry Panel across all markers. Target
average heterozygosity is 50±15%. The average heterozygosity across all markers was 37–50%.
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Figure 9   Amplicon Coverage for autosomal SNPs in the Precision ID Identity Panel across all markers. 96% of all
markers were within 2 standard deviations of the mean.
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Figure 10   Amplicon Coverage for the Precision ID Ancestry Panel across all markers. 98% of all markers were within
2 standard deviations of the mean.
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Figure 11   Amplicon Strand Balance for Y-Clade Markers in the Precision ID Identity Panel. 95% of the markers have
an average amplicon strand balance between 70-90%.
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Figure 12   Average Amplicon Coverage for Y-Clade Markers in the Precision ID Identity Panel. 97% of the markers
have an average amplicon coverage within 2 standard deviations of the mean.

Concordance results

The HID SNP Genotyper Plugin was used to analyze sequencing data for both the
Precision ID Identity Panel and the Precision ID Ancestry Panel. Concordance results
from genotype calls made using the plugin analysis output were compared to the
reference TaqMan® genotype data provided by Ken Kidd. Concordance data were
analyzed in the following subgroups:

• Genotype disparity (both alleles in the result disagree with the reference)
• Heterozygote disparity (data appear to have a dropout/loss of one allele)
• Homozygote disparity (data appear to have an additional allele)
• Concordant (both alleles match the reference)

A 10% minor allele frequency threshold was applied to genotype calls made using the
plugin.
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Genotype data for 32 individuals was analyzed for concordance (see Figure 13).
Library samples were prepared using 180 pg to 1 ng of input gDNA per PCR reaction,
and were sequenced on a single Ion 318™ Chip v2. TaqMan® genotype data for the 32
individuals was provided for 46 Ken Kidd SNPs. Two homozygote disparities were
observed. Genotype data between calls made using the plugin and the TaqMan® data
were 99.99% concordant.

Individual samples

%
 C

on
co

rd
an

ce

1

Figure 13   Precision ID Identity Panel concordance results
1 Homozygote disparity

Precision ID
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Genotype data for 24 individuals was analyzed for concordance (see Figure 14).
Library samples were prepared using 1 ng of input gDNA per PCR reaction, and were
sequenced on a single Ion 318™ Chip v2. TaqMan® genotype data for the 24
individuals were provided for 55 Ken Kidd SNPs. Two homozygote disparities and
one heterozygote disparity were observed. Genotype data between calls made using
the plugin and the TaqMan® data were 99.77% concordant.
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Figure 14   Precision ID Ancestry Panel concordance results
1 Homozygote disparity
2 Heterozygote disparity
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Effect of degradation on the probability of identity

Using data from the 1000 Genomes database, it was determined that 85 of 90
autosomal identity SNPs were unlinked. The unlinked SNP data set was degraded in
silico to determine the effect of degradation on the probability of identity. Data for
four populations from the 1000 Genomes database (East Asian, Ad Mixed American,
African, and European) along with values for a CE-based 21-plex STR assay were
plotted to detect changes in probability of identity with decreasing amplicon size (see
Figure 15). Based on these data, the identity SNP panel has lower combined match
probabilities than the standard CE-based STR assay at all levels of degradation.

Decreasing amplicon size
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Figure 15   Effect of degradation on probability of identity for the Precision ID Identity Panel using probability of identity
calculated from the 1000 Genomes database.

1 Amplicon size
2 Number of intact SNPs
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Panel throughput

Using 80% chip loading and 60% usable reads, the minimum amount of coverage and,
therefore, the number of individuals per Ion chip type can be determined for each
SNP panel.

To obtain a minimum of 300X coverage for 97% of the autosomal SNPs, an average
coverage depth of 738X is required. To obtain a minimum of 150X coverage for 97% of
the Y-clade SNPs, an average coverage of 236X is required. Using the condition of 80%
chip loading and 60% usable reads, this translates to the following run
recommendations by chip type:

• Ion 314™ Chip v2: 8 individuals
• Ion 316™ Chip v2: 38 individuals
• Ion 318™ Chip v2: 77 individuals

To obtain a minimum of 300X coverage for 97% of the autosomal SNPs, an average
coverage depth of 594X is required. Using the condition of 80% chip loading and 60%
usable reads, this translates to the following run recommendations by chip type:

• Ion 314™ Chip v2: 6 individuals
• Ion 316™ Chip v2: 30 individuals
• Ion 318™ Chip v2: 59 individuals

Precision ID
Identity Panel

Precision ID
Ancestry Panel
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Configure the HID SNP Genotyper
Plugin to add a Google™ Maps API

key

The HID SNP Genotyper Plugin needs to be configured to add a Google™ Maps API
key to access the Google™ Maps feature in population likelihood and admixture
results. If the key is not added, maps may not be displayed on the result pages.

Use the following step-by-step procedure first to generate the key, then use the key to
configure the plugin.

Generate a Google™ Maps API key

1. Go to https://console.developers.google.com/. Sign in using your Google™

account log in information.

C
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2. After signing in, click the Library link at the upper left corner of the screen, then
click Google Maps JavaScript API.

3. If you are configuring the Google™ Maps Javascript API for first time, click
Create Project.

Appendix C Configure the HID SNP Genotyper Plugin to add a Google™ Maps API key
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4. On the Dashboard screen, click Create.

5. Enter a project name, then click Create.

6. Click Enable to initiate key generation.

Appendix C Configure the HID SNP Genotyper Plugin to add a Google™ Maps API key
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7. On the next page, click Create credentials.

8. Click What credentials do I need? to generate a key.

Appendix C Configure the HID SNP Genotyper Plugin to add a Google™ Maps API key
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9. Click the Copy icon to the right of the field where the key appears.

Configure the plugin with the API key

1. Sign in to the Torrent Server via the Torrent Browser.

2. Go to the Plugins page by clicking , then Plugins.

3. Locate the HID_SNP Genotyper_v5_2_2 plugin, then click Configure under the
 menu for the plugin.

Appendix C Configure the HID SNP Genotyper Plugin to add a Google™ Maps API key
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4. Paste the API key you generated into the Google Map API Key field, then click
Submit Query.

Close the dialog. You should see that Google™ Maps is displayed for all the
previously generated results, as well as for future run results.

Note: Certain usage restrictions for the key may exist, and you may need to
regenerate it. In that case, repeat the steps to generate a new API key, then
reconfigure the plugin.

Appendix C Configure the HID SNP Genotyper Plugin to add a Google™ Maps API key
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Kits and reagents

Precision ID SNP panels

The Precision ID Library Kit supports the following Precision ID SNP panels:

Item Cat. No. Amount
Average
amplicon

size[1]

No. of
primer pairs Storage

Precision ID Ancestry Panel[2] A25642 1 tube 127 bp 165
– 30°C to – 10°C

Precision ID Identity Panel[3] A25643 1 tube 138 bp 124

[1] Libraries have an additional ~80 bp due to barcode adapters.
[2] Also available bundled with the Precision ID Library Kit as Cat. No. A26807.
[3] Also available bundled with the Precision ID Library Kit as Cat. No. A26808.

Precision ID IonCode™ 1−96 Kit in 96 Well PCR Plate

The Precision ID IonCode™ 1−96 Kit in 96 Well PCR Plate (Cat. No. A33586) contains a
set of 96 unique barcode adapters in a 96-well plate format for use in manual library
preparation. When used in combination with the Precision ID Library Kit, this kit
enables pooling of up to 96 libraries for multiplex sequence analysis.

Component Quantity No. of reactions Storage

Precision ID IonCode™ 1−96 Kit in
96 Well PCR Plate

1 × 96-well plate
(20 µL/well)

960
(10 reactions
per barcode)

–30ºC to –10ºC

D
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Documentation and support

Related documentation

Document Publication number

Precision ID Panels with Ion PGM™ System Application Guide MAN0015830

Precision ID Panels with Ion S5™ System Application Guide MAN0015831

Torrent Suite™ Software Help See thermofisher.com/
torrent-suite-software-docs.html

IonCode™ Barcode Adapters 1–384 Kit Product Information Sheet MAN0014640

Customer and technical support

For support:
• In North America—Send an email to HIDTechSupport@thermofisher.com, or

call 888-821-4443 option 1.
• Outside North America—Contact your local support office.
• For latest services and support information for all locations, go to 
thermofisher.com/support.

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth
in the Life Technologies' General Terms and Conditions of Sale found on Life
Technologies' website at www.thermofisher.com/us/en/home/global/
terms-and-conditions.html. If you have any questions, please contact Life
Technologies at www.thermofisher.com/support.
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